Users Guide for STHARVEST: Software to Estimate the Cost of Harvesting Small Timber

Roger D. Fight, Xiaoshan Zhang, and Bruce R. Hartsough
Roger D. Fight is a principal economist, U.S. Department of Agriculture, Forest Service, Pacific Northwest Research Station, P.O. Box 3890, Portland, OR 97208-3890; Xiaoshan Zhang was a graduate student and Bruce R. Hartsough is a professor, University of California, Department of Biological and Agricultural Engineering, Davis, CA 95616-5294. Xiaoshan Zhang is currently General Manager, A & C Wooden Products, Inc., 522 Medanos Ct., Fremont, CA 94539.
Abstract


The STHARVEST computer application is Windows-based, public-domain software used to estimate costs for harvesting small-diameter stands or the small-diameter component of a mixed-sized stand. The equipment production rates were developed from existing studies. Equipment operating cost rates were based on November 1998 prices for new equipment and wage rates for the Pacific Northwest. There are four ground-based and two cable harvesting systems. Harvesting costs can be estimated for both clearcutting and partial cutting for an average tree size ranging from 1 to 80 or 150 cubic feet depending on the system selected. Cost estimates are in U.S. dollars per 100 cubic feet or per green ton.

Keywords: Cost (logging), logging economics, timber management planning, software, simulation.
Summary

The STHARVEST software was developed with machine productivities found in the literature. Machine operating costs were based on 1998 equipment prices and wage rates for the Pacific Northwest. Productivities from a large number of studies were used so the simulation could include systems covering as wide a range of conditions as possible relevant to the harvesting of small-diameter trees. The STHARVEST model is a general model that is intended to be used for broad planning applications. It develops estimates of harvesting cost for six harvesting systems for an average tree size ranging from 1 to 80 or 150 cubic feet depending on the system selected. Cost estimates are in U.S. dollars per 100 cubic feet or per green ton. The STHARVEST application does not allow estimating of costs beyond those considered reasonable extrapolations of the data and beyond reasonable limits imposed by machine performance characteristics. It would probably be necessary to adjust productivity equations or equipment costs to make a reasonable cost estimate for a particular setting with a particular machine. The model was not designed for that purpose.
Introduction

This paper describes how STHARVEST can be used to estimate the cost of harvesting small-diameter timber for six types of harvesting systems over a wide range of stand conditions: two ground-based systems and one cable system with manual felling and two ground-based systems and one cable system with mechanical felling. Information is included to provide an understanding of system configuration and the situation being simulated; however, it was not our intent to provide the information needed to determine whether a particular system is appropriate for a particular situation. It is presumed that the user will get the technical and policy information needed to make that decision. The STHARVEST software, this document, and related documents can be found at http://www.fs.fed.us/pnw/data/soft.htm.

On public forest lands in the Western United States, the number of small-diameter trees is at an historic high because of fire suppression and other management activities. These small trees occur either in dense single-canopy stands or in a lower canopy level in multistoried stands. The prevailing attitude among many public land managers is that some proportion of these stands needs to be thinned to create a desirable mix of future stand conditions to meet forest health and habitat objectives and to reduce fire hazard. This generally involves removing part or all of the small-tree component of a stand.

The costs of harvesting and utilizing small trees can be prohibitive because the unit costs of harvesting smaller diameter trees are generally higher than those for larger diameter trees, and the unit costs of harvesting low volumes per acre are generally higher than those for higher volumes per acre. The cost penalties for harvesting low volumes per acre and small trees differ depending on the type of logging system used. For example, harvesting with a cable system is typically more expensive than with a ground-based system. In addition, the incremental cost increases are greater for cable systems when lower volumes per acre or smaller trees are harvested. It is therefore appropriate to consider, at the time the silvicultural prescription is developed, the type of harvesting system likely to be used in a stand. With that system in mind, harvest costs can be estimated that will indicate the effect of different management strategies on harvesting costs and net return. If logging costs are not considered, prescriptions may be developed that result in costs of harvest that exceed the value of the timber. To accomplish a thinning as a timber sale, there needs to be enough value in the trees to be removed to attract bidders. Harvesting costs are often the primary issues in whether or not a stand treatment will pay for itself. It is therefore important to have reasonable harvesting cost estimates for planning purposes in advance of preparing a timber sale. The STHARVEST software was developed for that specific purpose. It is intended to give reasonable cost estimates for a general type of harvesting equipment and conditions. Because it estimates an average cost for several alternative machines in a configuration, it is not designed to provide estimates for a specific harvest unit with a specific set of machines.

When calculating costs for a harvest system, STHARVEST does not explicitly consider the differences in calculated production rates between individual activities such as felling and yarding. Harvesting contractors use a variety of methods to maintain a reasonable balance between the activities. The STHARVEST software does take average system imbalances into account because the assumed utilization rates include interactive delays caused by the imbalances. Therefore, the costs reported by STHARVEST should be reasonable on average.
The STHARVEST software uses productivity equations drawn from the literature for 56 specific machines. Machines can be excluded from the model by setting their relevance to zero, a process described later. Capital and operating costs were developed by use of a standard machine cost approach with replacement purchase prices for new equivalent equipment. Equipment prices were for November 1998. The productivities and costs are used to develop stump-to-truck harvesting costs for the six system choices in STHARVEST. The resulting costs are an average of costs for each type of machine that might be included in a configuration weighted by the appropriateness of each machine for the conditions. These relevance weights vary from 1.0 (where the study is considered to be highly relevant) to zero in portions of the range where the relationships are not likely to be valid. Those interested in the detailed assumptions have access to them through the software and can override the hourly machine cost rates if they wish. See Hartsough and others (2001) for a description of the studies used, the equipment studied, and the relevance weighting procedure. In addition, user-defined machines can be added to the mix of machines that are included in a system. To use this feature, the user must add the cost per productive machine hour, an equation for volume per productive machine hour, and an equation or value for relevance.

The STHARVEST software is very similar in design and appearance to the PPHARVST software used to estimate harvesting costs in ponderosa pine (Pinus ponderosa Dougl. ex Laws.) plantations (Fight and others 1999). It will run on Windows 98 and newer operating systems.

Overview of STHARVEST

An STHARVEST exercise typically involves specifying a logging system, partial cut or clearcut, average yarding distance, slope, move-in distance, and number of acres being harvested at that location. Results can be made more relevant to local conditions by changing default values for machine costs, wood density, and the volume of tops and limbs (bonus wood) removed with the bole wood. Logging cost in either U.S. dollars per hundred cubic feet (US$/ccf) or dollars per green ton ($/gt) are shown for user-specified ranges of average tree size in cubic feet and number of harvested trees per acre. The resulting cost table provides an estimate of cost that can be applied to a single harvest, a series of harvests that might occur in a stand, or harvests applied to many stands with similar conditions. Figure 1 is an example of such a table and the key assumptions on which the table is based. This table has estimates of harvesting cost in dollars per ccf for average tree volumes of 3 to 50 cubic feet (shown in column A) and 25 to 200 cut trees per acre (shown in row 5).

Harvesting Systems and Conditions

Both whole-tree (WT) and log-length systems are included in STHARVEST. In a whole-tree system, trees are felled either mechanically or by hand and delivered to the landing where the trees are processed into logs. Tops and limbs remain at the landing or are scattered and not utilized. In a cut-to-length (CTL) system, trees are felled, limbed, and bucked either mechanically or by hand into logs at the stump. Logs are delivered to the landing by skidders, forwarders, or a cable yarder. Tops and limbs remain at the stump and are not utilized.

---

1 The use of trade or firm names in this publication is for reader information and does not imply endorsement by the U.S. Department of Agriculture of any product or service.
Table 1 shows the range of tree size and slope that STHARVEST accommodates. The following paragraphs provide a general description of the systems and the conditions for which they are well suited.

Ground-based systems are used where management conditions allow because they are typically less expensive and cause less damage to reserve trees than do cable-yarding systems. The potential to damage soils on steep or wet ground, however, limits tractive equipment to sites where the soil is relatively dry and where slopes are less than 30 to 40 percent. For slopes greater than about 10 percent, landings and road access for ground-based systems should normally be located on the downhill edge of the harvest unit. Skidding uphill on steeper slopes can cause excessive soil disturbance, and skidding or forwarding uphill is more costly.

With a ground-based manual-felling log-length system, trees are chainsaw-felled, limbed, and bucked into logs at the stump. Rubber-tired skidders (choker and grapple) collect the logs and transport them to the landing. Logs to be hauled in log form are loaded onto log trucks, and logs to be chipped for board products or fuel are processed through a disk chipper and blown into chip vans. A ground-based manual-felling log-length system is normally used where trees are large enough that they must be bucked into two or more pieces to remove them from the woods. It also may be used when managers wish to retain tops, limbs, and their associated nutrients on site.

With a ground-based manual-felling WT system, trees are felled with chainsaws but not limbed or bucked. Rubber-tired skidders (choker and grapple) collect and transport whole trees. Trees are chipped or processed mechanically with stroke or single-grip
processors and loaded onto trucks. A ground-based manual-felling WT system would typically be used for smaller trees than would the manual-felling log-length method and where feller bunchers are unavailable or where managers wish to confine machine traffic to a sparse network of skid trails. It often will be the most economical system where few trees per acre are to be removed. It is appropriate where managers wish to remove residues from the site to reduce fuel loading.

With a ground-based mechanized-felling WT system, trees are felled and bunched; drive-to-tree machines are assumed for flat ground, whereas swing-boom and self-levelling versions are included for steeper terrain. Rubber-tired grapple skidders transport bunches to the landing. Trees are chipped or processed mechanically with stroke or single-grip processors and loaded onto trucks. A ground-based mechanized-felling WT system is normally used when most or all of the trees to be removed are small enough to be handled by a feller buncher. It is useful where fuel loading is high because it removes tops and limbs from the stand. Because all operators are in machines, this system is safer than either of the manual-felling systems, where fallers and choker setters are exposed to the dangers of falling trees and rolling logs.

With a ground-based CTL system, mechanized single-grip harvesters fell, limb, and buck the trees at the stump and pile the logs at trailside. Logs are transported to the landing by forwarders. Logs to be hauled in log form are loaded onto log trucks, and logs to be chipped for board products or fuel are processed through a disk chipper and blown into chip vans. Because of the forwarder’s high center of gravity, the ground-based CTL system is limited to gentler slopes than are the other tractive systems, and at the upper limits of slope, to terrain that is fairly uniform rather than dissected. In addition, forwarder trails must run close to the fall line and must be laid out on a parallel, uniformly spaced network so the harvester can access the whole area. The physical constraints of the harvester and forwarder limit this system to trees under about 20 inches diameter at breast height. Mills that prefer logs longer than the forwarder can carry may pay less for short CTL logs. Forwarders carry rather than drag logs and can travel on mats of the tops and limbs left by harvesters. Managers may therefore prefer CTL systems when it is critical to leave residues onsite, minimize soil disturbance, begin operations earlier in the year and continue longer, and minimize aesthetic impact. Cut-to-length systems have safety advantages and can operate with small landings, but they are typically more expensive than mechanized-felling WT systems.

Table 1—Ground-based or cable systems and conditions under which they customarily operate

<table>
<thead>
<tr>
<th>Tree size and slope</th>
<th>Manual felling</th>
<th>Mechanical felling</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Ground based</td>
<td>Cable</td>
</tr>
<tr>
<td>Maximum tree size (cubic feet)</td>
<td>150</td>
<td>150</td>
</tr>
<tr>
<td>Minimum tree size (cubic feet)</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Maximum slope (percent)</td>
<td>40</td>
<td>None</td>
</tr>
</tbody>
</table>
Cable-Yarding Systems

Cable-yarding systems are used where terrain is too steep or wet for ground-based systems or to reach across streams to areas not accessible by road. Yarding, however, requires deflection, that is, concave terrain profiles, in order to lift logs and avoid soil disturbance. Experience and careful planning are needed to ensure adequate deflection. In partial cutting, road access and landings usually should be located along the uphill edge of a harvest unit because yarding downhill can cause excessive damage to residual trees. Stand damage is less of a problem when the trees being removed are smaller than the residual trees. All the cable-yarding studies included in STHARVEST were for uphill yarding, so the results should be applied to downhill yarding with caution.

With a manual-felling log-length cable-yarding system, trees are chainsaw-felled, limbed, and bucked at the stump. Cable yarders transport the logs to the landing. The types of yarders include Idaho jammers, live skylines, and running skylines. Logs to be hauled in log form are loaded onto log trucks, and logs to be chipped for board products or fuel are processed through a disk chipper and blown into chip vans. Manual felling is the most common means of preparing trees for yarding because it can be used on essentially any type of terrain.

With a CTL cable-yarding system, mechanized single-grip harvesters fell, limb, and buckle the trees and bunch the logs along predesignated yarding corridors and along harvester trails between the corridors. A cable yarder (a standing skyline with motorized slackpulling carriage was the only machine for which data were available) transports the bunched logs to the landing. Logs to be hauled in log form are loaded onto log trucks, and logs to be chipped for board products or fuel are processed through a disk chipper and blown into chip vans. The CTL system is applicable where the terrain is gentle enough and trees are small enough to allow the use of a harvester. It is not very common but shows promise for reducing the costs and residual stand damage associated with manual-felling log-length yarding. Cable yarders do not have the log-length constraints that forwarders have.

How to Get Started With STHARVEST

The STHARVEST software runs under Windows 98 and newer operating systems. It produces a table of harvesting costs in US$/ccf or $/gt over a range of average tree size (cubic feet per tree) and number of trees cut per acre. The harvesting conditions are chosen by the user selecting options on the program results screen.

The application was first created as an Excel spreadsheet then converted to a stand-alone program. All the calculation routines are available to the user through the Formula One Workbook Designer (double right-click within the spreadsheet portion of the program window to open Formula One) or as an Excel spreadsheet (open any saved spreadsheet in Excel). No software beyond STHARVEST itself is necessary to use the program.

Installing STHARVEST

Although STHARVEST does not require a spreadsheet program, it does require some dynamic link library files and other files that may not be available on some personal computer systems. Some of these are supplied with the program. To install STHARVEST and the required files, execute the setupex.exe file that you downloaded from the STHARVEST Web page and follow the instructions in the setup program. The files will be transferred to the appropriate subdirectories on the hard disk, and an STHARVEST program icon will be created.
Double-click on the STHARVEST icon or STHARVEST.exe. The program results screen will appear (fig. 2). The following four steps are required.

1. Click on the top left combo box to select the type of harvesting system: ground-based manual log, ground-based manual WT, ground-based mech WT, ground-based CTL, cable manual log, or cable CTL.

2. In the next box below, select the type of harvest: clearcut or partial cut.

3. In column A of the spreadsheet area, enter a column of average tree sizes, in cubic feet, beginning in cell A6. For example, in figure 1, tree volumes of 3, 10, 20, and 50 have been entered. Any number of average tree sizes may be entered, but no cell within the range should be left blank because results for entries beyond a blank cell will not be calculated. The software follows the rules shown in table 1 for maximum and minimum average tree size and will not calculate results for average tree sizes that are outside that range. The average tree sizes can be of any value within the valid range; they do not have to be at equal increments.

4. In row 5, enter a row of removals, in number of trees per acre, beginning with cell B5. For example, in figure 1, cut trees per acre of 25, 50, 100, and 200 have been entered. Results will only be calculated for removals of 1,000 or fewer trees per acre.

These are the minimum data entry requirements for the program to run with the numbers that come preloaded in other cells. Modification of these default values is discussed below. Clicking one of the Calculate buttons will run the program and display the cost results in the body of the spreadsheet table in the requested units. You can save the results, modify the input data, and resubmit to generate new results, or you can click on the Clear button to clear results and start over. The Excel spreadsheet used by STHARVEST must be saved in Excel 5.0 format to be used again in the STHARVEST program. These operations are described in detail in a subsequent section.

Slope, one-way slope skidding, forwarding, or yarding distance, and the hourly costs per productive machine hour for each of the different machines can be changed by making entries in the appropriate boxes above the spreadsheet. See the glossary for specific definitions of input variables. When any of these inputs are changed, be sure to click Calculate again so that the results will reflect the new inputs.

The machine operating costs should include the full cost of ownership and labor. The number that first appears when a change is to be made in the hourly costs of one of the machines is the default value. Once it is changed, the new value will be used in calculations, and the new value will be displayed when another change is requested. If the session is saved, the changed value will remain the operative value when that session is reopened. The program default values for machine costs are preserved, however, and can be returned for use in calculations by opening the dialog box to change the value again and entering zero. The Machine Costs sheet is where machine costs are calculated; that and other calculation sheets are found at the bottom of the window and are discussed in a subsequent section.

The one-way distance is interpreted as either a skidding, forwarding, or yarding distance, depending on the harvesting system selected. Cable yarders have physical upper bounds on maximum yarding distance, based on the line capacities of their drums. Yarders with lower capacities will have relevance values of zero as their capacities are...
exceeded. The maximum reach for cable yarders in STHARVEST is 2,000 feet. The value that is entered, however, is the average distance. For example, a rectangular unit with a maximum yarding distance of 2,000 feet would have an average yarding distance of about 1,000 feet, whereas a triangular unit with a maximum yarding distance of 2,000 feet would have an average yarding distance of about 1,300 feet. The maximum average value that STHARVEST will accept is 1,300 feet.

Move-in costs can be a significant portion of the total cost when total removed volume is low. Move-in costs will be included in the results only if the Include box, under move-in costs, is checked. Values for the area harvested and the one-way move-in travel distance for the equipment can be modified as needed.

The software uses a default value for the proportion of log volume that is chipped in the woods. The proportion decreases as tree size increases. Figure 3 shows this relationship. This value can be fixed by the user if desired; for example, at zero, if there is no in-woods chipping. This is done by unchecking the Use Default box above the spreadsheet and entering a number for the percentage of volume to be chipped. This number will be applied to all sizes of trees included in the results table.

A wood density is used in STHARVEST to convert machine productivities from studies done with cubic measurements to costs per ton and to convert machine productivities from studies done with weight measurements to costs per ccf. The value used is not just the weight of a cubic foot of green wood. Volume measurements are made inside bark, but weights include the bark. The weight that goes into the Green density cell

---

Figure 2—Window as it appears when STHARVEST is opened.
above the spreadsheet is therefore the green weight of bole wood and bark per cubic foot of bole wood. The program default value is 50 pounds per cubic foot. This value can be changed to reflect local conditions.

When whole-tree systems are used, there is more than just bark that comes along per cubic foot of bole wood. Tops and branches also are brought to the landing. The weight of this material affects turn weights and times. It also contributes to the weight of material that will be recovered if whole trees are chipped and therefore affects the costs per ton. The **Bonus Wood** cell above the spreadsheet takes a percentage that is applied to the weight per cubic foot to account for the weight and volume of this material. This percentage is applied to all tree size classes. Different bonus wood percentages can be applied to different size trees by putting the desired percentages in column L under **Bonus Wood** in the spreadsheet. The value in the **Bonus Wood** cell above the spreadsheet will be ignored if bonus wood percentages are entered in the spreadsheet.

### Saving and Printing

**Save** and **Print** commands are found under the **File** menu. It is particularly important to save a spreadsheet if there are changes to machine costs or table entries that will be used in other cost simulations. The spreadsheet used by STHARVEST can only be saved in Excel 5.0 format. This is the only format that can be reopened by STHARVEST. To save the results and assumptions entered, select **Save** under the **File** menu, specify a location and a file name, and click **Save**. If the file is saved to the default file name, the default file will be overwritten and can only be reset to defaults by reinstalling the program.

To print results, highlight the area to be saved, select **Define Print Area** under the **File** menu, then select **Print** under the **File** menu and direct the output to the desired printer.
The Formula One Workbook Designer also can be used to save or print. One feature that it has that is not available from within STHARVEST is the ability to copy and paste the results into another application like a word processor or spreadsheet. Double-click the right mouse button while in the spreadsheet portion of STHARVEST to activate the Formula One Workbook Designer. This spreadsheet program offers great flexibility; it is compatible with Excel, and its use is similar to that of Excel’s. If the spreadsheet is saved from Formula One, the Excel 5.0 format must be selected for the saved file to be reopened in STHARVEST. It can be saved in other formats for other uses. If tabbed text (txt) format is selected, only the active sheet from which the command is executed can be saved. Additional sheets can be saved by clicking the tab to make them active and saving them one at a time.

Exit either application by clicking the X in the upper right corner of the screen. The STHARVEST program cannot be closed while the Formula One Workbook Designer is active.

If values of internal variables need to be modified, certain harvesting conditions changed, or calculations of cost or productivity verified, these can be done with STHARVEST by working in the Excel workbook through Formula One. Double-click on the right mouse button to open Formula One. Most cells are protected to avoid inadvertent changes. To modify cells that are protected, uncheck Enable Protection under the Sheet menu. After making changes, save them with the Write command on the File menu. Be sure to save in Excel format if you intend to open the modified sheet with the STHARVEST program.

Each of the cost-component sheets (Felling, Fell & Bunch, Harvesting, Skidding, Forwarding, Cable Yarding, Processing, Loading, and Chipping) has provision for one or more user-defined machines. User-defined machines can be added from within STHARVEST. Areas where changes are required to add a new machine have a light blue background. With the exception of cable yarders, adding a new machine requires putting in the productivity in ccf per productive machine hour and a number or equation for the relevance of that machine. Care should be taken not to calculate costs for ranges of conditions where the assigned relevance is inappropriate. The cost per productive machine hour should be reviewed and modified as needed. Adding a cable yarder requires putting in the average turn time in minutes and a number or equation for the relevance of that machine. In addition, the cost per ccf for moving between landings and shifting cables is required.

The STHARVEST workbook includes 13 sheets. Twelve are calculation sheets; the 13th (Results) is used only to display tabular results calculated in other sheets. Tables of simulated harvesting costs can be run from the Results sheet without ever accessing other sheets. The additional sheets are accessible for those who want to understand the derivation of results or change some of the model assumptions. Equations can be viewed on the formula bar by checking Show Formula Bar under the Options menu.

**Results**—The Results sheet contains the results of one or more cost simulations. It also contains a listing of values that have been used in making the simulations so that simulation assumptions can be verified and retained with the results. If a harvesting cost file is requested (a command found under File menu) for use with the financial evaluation of ecosystem management activities (FEEMA) software (Fight and Chmelik 1998), a file will be created that can be directly used in FEEMA analyses. It is created...
from the table found at the bottom of the **Results** sheet. The FEEMA harvesting cost file is always given in $/ccf because that is the only format accepted by the FEEMA software.

**Inputs and Summary**—The **Inputs and Summary** sheet shows intermediate results calculated for the last harvest cost calculation executed. It provides a way to see the cost of each component of a harvesting system that are included in the total cost shown in the **Results** sheet. If a single harvest cost calculation is requested (by entering only one tree volume and only one value for cut trees per acre in the results sheet), the intermediate calculations will be for that harvest cost calculation. This provides a way to view the calculations that produce a particular result.

**Relevance Weight Inputs**—The **Relevance Weight Inputs** sheet has the calculation of relevance weights for each machine or study included in a system. The cost for a system is an average of the costs of all machines weighted by their relevance weights. A relevance weight of zero would eliminate that machine or study from the average. This sheet also has a column of user overrides for the calculated weights. Machines can be excluded from the calculation of average cost by putting in a weight of zero in column B by those systems. User-supplied weights that are within the valid range of zero to one will be used except when the calculated weight is zero. If the calculated weight is zero, the user-supplied weight will be ignored to prevent extrapolation beyond what is deemed a reasonable use of the machine. Note that the current model weight shown in column C is for the last calculation made by the model and depends on the circumstances input to STHARVEST. Column K shows the weights used in calculations. They will be identical to the model-calculated weights unless user-supplied weights are used.

**Machine Costs**—The **Machine Costs** sheet shows the detailed calculation of the machine cost per hour for each of the six generic harvesting systems. This is where the default machine costs are calculated. These costs can be overridden by use of the **Change Machine Cost** pull-down menu.

**Move-In-Costs**—The **Move-In-Costs** sheet shows how the equipment moving costs are calculated for each of the six generic harvesting systems.

**Felling**—The **Felling** sheet shows the costs per ccf for three felling productivity equations drawn from the literature and the relevance assigned for the harvest cost calculation shown on the **Inputs and Summary** sheet.

**Fell & Bunch**—The **Fell & Bunch** sheet shows the costs per ccf for seven feller buncher productivity equations drawn from the literature and the relevance assigned for the harvest cost calculation shown on the **Inputs and Summary** sheet.

**Harvesting**—The harvesting sheet shows costs per ccf for seven harvester productivity equations drawn from the literature and the relevance assigned for the harvest cost calculation shown on the **Inputs and Summary** sheet.

**Skidding**—The skidding sheet shows costs per ccf for eight rubber-tired skidder productivity equations drawn from the literature and the relevance assigned for the harvest cost calculation shown on the **Inputs and Summary** sheet.

**Forwarding**—The forwarding sheet shows costs per ccf for four forwarder productivity equations drawn from the literature and the relevance assigned for the harvest cost calculation shown on the **Inputs and Summary** sheet.
Cable yarding—The cable yarding sheet shows costs per ccf for 12 cable yarder productivity equations drawn from the literature and the relevance assigned for the harvest cost calculation shown on the Inputs and Summary sheet.

Processing—The processing sheet shows costs per ccf for five processor productivity equations drawn from the literature and the relevance assigned for the harvest cost calculation shown on the Inputs and Summary sheet.

Loading—The loading sheet shows costs per ccf for six loading productivity equations drawn from the literature and the relevance assigned for the harvest cost calculation shown on the Inputs and Summary sheet.

Chipping—The loading sheet shows costs per ccf for four chipping productivity equations drawn from the literature and the relevance assigned for the harvest cost calculation shown on the Inputs and Summary sheet.

Cut Tree List—The Cut Tree List sheet is provided for those analysts that want to use the STHARVEST spreadsheet without the interface. Procedures have been developed to allow the spreadsheet to be called by another program to simulate harvesting costs for specific conditions as part of a broad analysis of fuels treatment. That use is not documented here, but the sheet is included in the program so that one spreadsheet will serve both purposes. Values entered on this sheet will not affect the results shown in the table on the Results sheet.

Running a Modified Version of STHARVEST

To reload a modified version of STHARVEST saved in Excel 5.0 format, open STHARVEST and then open the modified version with the Open command on the File menu. Note that the name of the active file is shown at the top of the STHARVEST window to distinguish between the default file and any saved file.

Glossary

Area harvested—The total area in acres to be harvested by one harvesting system during one entry.

Bonus wood—The limb and upper stem volume that is brought to the landing along with the merchantable bole wood when whole-tree skidding or yarding systems are used.

Chip fraction—The proportion of volume that is assumed to be turned into chips rather than logs for other products, expressed as a percentage.

Green density—The weight of green wood and bark per cubic foot of bole wood measured in pounds per cubic foot.

One-way move-in distance—Distance in miles that equipment is transported to reach the harvest unit.

Operator wage and benefit rate—Total cost per scheduled hour for the operator or crew associated with one machine.

Skidding/forwarding/yarding distance—This is the skidding distance for the ground-based skidder systems or the forwarding distance for the CTL system or the yarding distance for the cable yarding systems. In all cases, it refers to the average (not external) one-way distance measured along the slope.

Slope—The average fall-line slope for the harvest unit, measured as a percentage.

Trees per acre—Number of harvested trees per acre.
**Tree volume**—Average merchantable volume in cubic feet to the merchantable top diameter of trees being harvested.

**Utilization rate**—Productive hours divided by scheduled hours.

### Metric Equivalents

<table>
<thead>
<tr>
<th>When you know:</th>
<th>Multiply by:</th>
<th>To find:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acres (ac)</td>
<td>0.40</td>
<td>Hectares</td>
</tr>
<tr>
<td>Cubic feet (cf)</td>
<td>0.028</td>
<td>Cubic meters</td>
</tr>
<tr>
<td>Feet (ft)</td>
<td>0.305</td>
<td>Meters</td>
</tr>
<tr>
<td>Inches (in)</td>
<td>2.54</td>
<td>Centimeters</td>
</tr>
<tr>
<td>Tons</td>
<td>0.91</td>
<td>Tonnes</td>
</tr>
</tbody>
</table>

### Literature Cited


The Forest Service of the U.S. Department of Agriculture is dedicated to the principle of multiple use management of the Nation’s forest resources for sustained yields of wood, water, forage, wildlife, and recreation. Through forestry research, cooperation with the States and private forest owners, and management of the National Forests and National Grasslands, it strives—as directed by Congress—to provide increasingly greater service to a growing Nation.

The U.S. Department of Agriculture (USDA) prohibits discrimination in all its programs and activities on the basis of race, color, national origin, gender, religion, age, disability, political beliefs, sexual orientation, or marital or family status. (Not all prohibited bases apply to all programs.) Persons with disabilities who require alternative means for communication of program information (Braille, large print, audiotape, etc.) should contact USDA's TARGET Center at (202) 720-2600 (voice and TDD).

To file a complaint of discrimination, write USDA, Director, Office of Civil Rights, Room 326-W, Whitten Building, 14th and Independence Avenue, SW, Washington, DC 20250-9410 or call (202) 720-5964 (voice and TDD). USDA is an equal opportunity provider and employer.

Pacific Northwest Research Station

<table>
<thead>
<tr>
<th>Web site</th>
<th><a href="http://www.fs.fed.us/pnw">http://www.fs.fed.us/pnw</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Telephone</td>
<td>(503) 808-2592</td>
</tr>
<tr>
<td>Publication requests</td>
<td>(503) 808-2138</td>
</tr>
<tr>
<td>FAX</td>
<td>(503) 808-2130</td>
</tr>
<tr>
<td>E-mail</td>
<td><a href="mailto:pnw_pnwpubs@fs.fed.us">pnw_pnwpubs@fs.fed.us</a></td>
</tr>
<tr>
<td>Mailing address</td>
<td>Publications Distribution</td>
</tr>
<tr>
<td></td>
<td>Pacific Northwest Research Station</td>
</tr>
<tr>
<td></td>
<td>P.O. Box 3890</td>
</tr>
<tr>
<td></td>
<td>Portland, OR 97208-3890</td>
</tr>
</tbody>
</table>